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This chapter introduces the product overview, CODESYS software, networking application,

packaging list, appearance, buttons, indicators and interfaces.

The ED-PAC3020 is a real-time CODESYS programmable automation controller, pre-installed by

default with a multi-core CODESYS runtime. Depending on the application scenario and user

requirements, it offers programmable logic system configurations with either 2GB DDR + 128GB

SSD  or 8GB DDR + 256GB SSD .

WARNING

The ED-PAC3020 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

The ED-PAC3020 provides commonly used interfaces such as HDMI, USB, Ethernet, RS232, and

RS485, integrates RTC, and is primarily used in industrial control and IoT fields.

The ED-PAC3020 supports connection to remote EtherCAT-based I/O modules (e.g., couplers, DI,

DO, AI, AO) via an EtherCAT network. The device integrates the CODESYS Control Runtime

System, supporting IEC 61131-3 programming standards and industrial communication protocols

like EtherCAT and Modbus TCP. Users can optionally enable additional functionalities by licensing

features such as:

TargetVisu

WebVisu

Softmotion

CNC + Robotics

EtherCAT Master

Modbus TCP Master

OPC UA Server

Custom configurations are available to meet specific application requirements.

1 Hardware Manual

1.1 Overview

• 

• 

• 

• 

• 

• 

• 
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CODESYS (Controller Development System) is an open industrial automation software

development platform that provides a full-stack solution for programming, debugging, and

maintaining programmable logic controllers (PLCs), industrial PCs (IPCs), and embedded control

systems. Compliant with the IEC 61131-3 international standard, it supports complex logic control,

multi-axis motion control, industrial communication protocol integration, and real-time data

processing. It is widely used in smart manufacturing, energy management, logistics automation,

and other industrial fields.

Key Features of CODESYS:

Standardized Programming Language Support 

Full compatibility with the IEC 61131-3 programming languages: 

Ladder Diagram (LD)

Function Block Diagram (FBD)

Structured Text (ST)

Instruction List (IL)

Sequential Function Chart (SFC)

Supports Object-Oriented Programming (OOP) extensions for large-scale complex projects.

Cross-Platform Development & Deployment 

Development Environment: Compatible with Windows and Linux operating systems, offering

a unified engineering interface.

Target Systems: Deployable on 2,000+ industrial controller hardware platforms, including

ARM/X86 architectures.

Modular Engineering Libraries 

Prebuilt Libraries: Include industrial protocol stacks (Modbus/TCP, OPC UA, EtherCAT) and

advanced control modules (PID control, CNC interpolation algorithms).

Custom Libraries: Support encapsulation and reuse of Function Blocks and POUs (Program

Organization Units).

Visual Debugging & Diagnostic Tools 

Real-time monitoring of variables, I/O mapping, and task execution status with waveform

analysis.

Advanced debugging tools: breakpoints, step-by-step execution, and cross-referencing for

rapid fault diagnosis.

Integrated HMI development tools for seamless SCADA system integration.

The ED-PAC3020 supports CODESYS V3.5 SP19 and later versions.

The ED-PAC3020 features EtherCAT, Ethernet, RS485 and RS232 interfaces, enabling multi-layer

network communication to meet diverse application requirements across various scenarios. A

typical application topology is illustrated in the figure below:

1.2 ​Introduction to CODESYS Software

• 

◦ 

▪ 

▪ 

▪ 

▪ 

▪ 

◦ 
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◦ 
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◦ 
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◦ 

◦ 
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1.3 Networking Application
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1 x ED-PAC3020 Unit

4 x Pads

Introducing the functions and definitions of the interfaces on each panel

Introducing front panel interface types and definitions.

NO. Function Definition

1

1.4 Packing List

• 

• 

1.5 Appearance

1.5.1 Front Panel
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NO. Function Definition

1 x RS232 port, 3-Pin 3.5mm pitch phoenix terminal, which is used to connect the third-party control

equipment.

2 2 x green UART indicators, which is used to check the communication status of UART port.

3 1 x red power indicator, which is used to check the status of device power-on and power-off.

4 1 x green system status indicator, which is used to view the status of system read/write operations.

5 1 x Audio Output (HPO), 3.5mm audio jack connector (green), stereo audio output.

6 1 x Audio Input (LINE IN), 3.5mm audio jack connector (red), supporting stereo audio input.

7

1 x RS485 port, 3-Pin 3.5mm pitch phoenix terminal, which is used to connect the third-party control

equipment.

8 2 x USB 2.0 ports, Type-A connector, each channel supports up to 480Mbps transmission rate.

9 2 x USB 3.0 ports, Type-A connector, each channel supports up to 5Gbps transmission rate.

10

1 x Ethernet interface (10/100/1000M auto-negotiation), RJ45 connector, EtherCAT communication

interface for connecting to EtherCAT networks, with PoE (Power over Ethernet) support.

Introducing rear panel interface types and definitions.

NO. Function Definition

1 1 x power button, which is used to turn on and turn off the device.

2

1 x Micro SD card slot, reserved for future use.

Note: The device boots from the SSD by default. This Micro SD card slot is reserved for potential

expansion.

Introducing side panel interface types and definitions.

1.5.2 Rear Panel

1.5.3 Side Panel
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NO. Function Definition

1 1 x DC input, USB Type-C connector, which supports 5V 5A power input.

2 2 x HDMI ports, Micro HDMI connector, which can connect a display and supports 4K 60Hz

The ED-PAC3020 includes a ON/OFF button, and the silkscreen is "ON/OFF". If you run

Raspberry Pi Desktop, you can initiate a clean shutdown by briefly pressing the power button. A

menu will appear asking whether you want to shutdown, reboot, or logout:

TIP

If you run Raspberry Pi Desktop, you can press the power button twice in quick

succession to shut down.

This section explains the status and meanings of the indicators integrated into the ED-PAC3020

device.

​Indicator Status Description

PWR

On The device has been powered on.

Blink

Power supply of the device is abnormal, please stop the

power supply immediately.

Off The device is not powered on.

ACT Blink

The system started successfully and is reading and writing

data.

1.6 Button

1.7 ​Indicator
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​Indicator Status Description

Off

The device is not powered on or does not read and write

data.

COM1~COM2

On/Blink Data is being transmitted

Off

The device is not powered on or there is no data

transmission.

Yellow indicator of Ethernet port

On The Ethernet connection is in the normal state.

Blink The Ethernet connection is abnormal.

Off The Ethernet connection is not set up.

Green indicator of Ethernet port

On The Ethernet connection is in the normal state.

Blink Data is being transmitted over the Ethernet port.

Off The Ethernet connection is not set up.

TIP

The function of the PWR/ACT indicator on the Raspberry Pi 5 has been transferred to the

separate PWR and ACT indicators by default, so the PWR/ACT indicator remains on after

the device is powered on.

Introducing the definition and function of each interface in the product.

The ED-PAC3020 device includes one power input interface, which utilizes a USB Type-C

connector labeled "PWR IN" and supports a 5V 5A power input.

TIP

In order for Raspberry Pi 5 to achieve better performance, it is recommended to use a 5V

5A power adapter.

The ED-PAC3020 device includes one auto-negotiating 10/100/1000M Ethernet interface with an

RJ45 connector featuring status LEDs, labeled as " ". This interface serves as an EtherCAT

communication port for connecting to EtherCAT networks and supports PoE (Power over Ethernet)

power delivery.

1.8 ​Interface

1.8.1 Power ​Interface

1.8.2 1000M Ethernet ​Interface (EtherCAT)
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The ED-PAC3020 device includes 2 HDMI interfaces using Micro HDMI connectors, labeled 

"HDMI", for connecting HDMI displays. These interfaces support video output up to 4Kp60.

TIP

Some third-party Micro HDMI cables may have shorter Micro HDMI connectors, which

could cause connection issues. It is recommended to use the official Raspberry Pi Micro

HDMI to Standard HDMI cable for optimal compatibility.

The ED-PAC3020 device includes 2 USB 2.0 interfaces with standard Type-A connectors, labeled

as " ". These interfaces support connecting standard USB 2.0 peripherals and offer a maximum

transfer rate of 480Mbps.

The ED-PAC3020 device includes 2 USB 3.0 interfaces with standard Type-A connectors, labeled

as " ". These interfaces support connecting standard USB 3.0 peripherals and offer a maximum

transfer rate of 5Gbps.

The ED-PAC3020 device includes 1 RS232 interface with a 3-Pin 3.5mm pitch Phoenix terminal,

labeled "TX/RX/GND".

Pin Definition

Terminal pins are defined as follows:

Pin ​ID Pin Name

1 TX

2 RX

3 GND

The RS232 interface corresponds to the following pin names on the Pi5:

Signal Pi5 GP​IO Name Pi5 Pin Out

TX GPIO4 UART3_TXD

RX GPIO5 UART3_RXD

Connecting Cables

1.8.3 HDM​I ​Interface

1.8.4 USB 2.0 ​Interface

1.8.5 USB 3.0 ​Interface

1.8.6 RS232 ​Interface
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The RS232 wiring schematic is as follows:

The ED-PAC3020 device includes 1 RS485 interface with a 3-Pin 3.5mm pitch Phoenix terminal,

labeled "A/B/GND".

Pin Definition

Terminal pins are defined as follows:

Pin ​ID Pin Name

1 A

2 B

3 GND

The RS485 interface corresponds to the following pin names on the Pi5:

Signal Pi5 GP​IO Name Pi5 Pin Out

A GPIO12 UART5_TXD

B GPIO13 UART5_RXD

Connecting Cables

The RS485 wiring schematic is as follows:

RS485 Terminating Resistor Configuration

The ED-PAC3020 device includes 1 RS485 interface. A 120Ω termination resistor is reserved

between the A and B lines of the RS485 circuit. Inserting a jumper cap enables this termination

resistor. By default, no jumper is installed, rendering the 120Ω termination resistor inactive. The

termination resistor is located at J7 on the PCBA (printed circuit board assembly).

TIP

The device case must be opened to inspect the 120Ω termination resistor.

1.8.7 RS485 ​Interface
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The ED-PAC3020 device includes 1 audio input interface (LINE IN), a red 3.5mm audio jack,

labeled as " ", which supports stereo input.

The ED-PAC3020 device includes 1 audio output interface (HPO), a green 3.5mm audio jack,

labeled as " ", which supports stereo output.

1.8.8 Audio ​Input

1.8.9 Audio Output
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The ED-PAC3020 device is designed for desktop placement by default and supports wall

mounting with the optional ED-ACCBKT-L3020 wall-mount bracket from our company.

TIP

The ED-PAC3020 packaging box does not include the ED-ACCBKT-L3020 by default.

Users must purchase it separately.

Preparation:

Prepared a Phillips-head screwdriver.

Obtained the ED-ACCBKT-L3020 wall-mount bracket.

Step:

Use a Phillips screwdriver to unscrew the four M2.5 screws on the side of the ED-IPC3020

counterclockwise.

Align the left and right brackets of the ED-ACCBKT-L3020 with the screw holes on both sides of

the ED-PAC3020, insert the four M2.5*6 screws, and tighten them clockwise with a Phillips

screwdriver to secure the ED-ACCBKT-L3020 to the sides of the ED-PAC3020.

Based on the spacing and diameter of the wall-mounting screw holes of the ED-ACCBKT-

L3020 left and right brackets (refer to the diagram below), drill holes in the wall accordingly,

then proceed with wall-mounted installation of the device.

Unit: mm

Tolerance: 0.5-6±0.05, 6-30±0.1, 30-120±0.15

2 ​Installing the Device

• 

• 

1. 

2. 

3. 

• 

• 
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This chapter details the specific procedures for connecting cables and powering on the device.

This section describes the procedures for connecting cables to the device.

Preparation:

Obtained fully functional accessories such as a switch, monitor, mouse, keyboard, I/O

expansion module, and power adapter.

Available functional network connection.

Available functional cables: HDMI cable and Ethernet cable.

Schematic diagram of connecting cables:

Please refer to 1.8 Interface for the pin definition of each interface and the specific method of

wiring.

TIP

Some third-party Micro HDMI cables may have shorter Micro HDMI connectors, which

could cause connection issues. It is recommended to use the official Raspberry Pi Micro

HDMI to Standard HDMI cable for optimal compatibility.

3 Booting The Device

3.1 Connecting Cables

• 

• 

• 
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Once the ED-PAC3020 is connected to power, the system will begin to boot up.

Red PWR indicator: Lights up to indicate the device is receiving power.

Green ACT indicator: Blinks to signal normal system startup. The Raspberry Pi logo will then

appear in the upper-left corner of the screen.

TIP

Default username is pi , default password is raspberry .

If the device is factory-installed with the Desktop OS, it will boot directly into the desktop interface

upon startup, as shown in the figure below.

3.2 Booting The System For The First Time

• 

• 

3.2.1 Raspberry Pi OS (Desktop)
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If the device is factory-installed with the Lite OS, it will automatically log in using the default

credentials after startup. The figure below indicates that the system has booted successfully.

3.2.2 Raspberry Pi OS (Lite)
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This chapter details the specific operations involved in using CODESYS.

WARNING

The ED-PAC3020 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

TIP

The installed CODESYS IDE version must be 3.5.19 or higher, and the PC operating

system must be Windows 10 or Windows 11 (64-bit recommended).

Download the installation package from the official CODESYS website. The download URL is 

https://store.codesys.com/de/ (https://store.codesys.com/de/) .

TIP

When downloading from the CODESYS official website for the first time, you must first

register and log in to your account.

Right-click the downloaded installer and select "Run as administrator" from the context menu.

Click "Install" in the opened installation interface, and keep the default configuration during the

installation process.

After the installation is complete, click "Finish" to close the installation interface.

4 CODESYS Programming

4.1 CODESYS Software Download and ​Installation

1. 

2. 

3. 

4. 
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Before connecting to the device via CODESYS, you need to download and install the device

description file first.

TIP

The device’s default Ethernet port IP address is 192.168.0.100. To modify it, refer to 

Configuring Ethernet IP.

Preparation:

A CODESYS-authorized ED-PAC3020 is available.

A functional Ethernet cable is available.

A Windows PC is prepared, with its IP address configured to the same subnet as the device.

For example, if the device’s IP (1000M Ethernet port) is 192.168.0.100 , set the PC’s IP to 

192.168.0.99 .

Steps:

Connect the device's Ethernet port to the PC via an Ethernet cable, then power on the device.

Enter http://192.168.0.100:8100  in the PC’s web browser to access the "PLC Setting"

interface.

In the "Device Info" section, click the "​​[Download] Device Description File" button to download

the corresponding ".xml" format device description file.

4.2 Obtaining and ​Installing Device Description File

4.2.1 Obtaining Device Description File

• 

• 

• 

1. 

2. 

3. 
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TIP

The device files are available for download within the documentation. Different CODESYS

licenses correspond to different device files. For specific descriptions and download paths,

please refer to Device File and Function Correspondence Table.

Preparation:

A PC installed with CODESYS software version V3.5 SP19 (64-bit).

An ED-PAC3020 device with a valid CODESYS license and its corresponding device

description file.

Connect both the PC and ED-PAC3020 to the network, ensuring their IP addresses are within

the same subnet.

Steps:

Double-click the CODESYS icon on the PC desktop to open the CODESYS software. From the

menu bar, select “Tools” → “Device Repository”.

In the opened "Device Repository" pane, click "Install".

4.2.2 ​Installing Device Description File

• 

• 

• 

1. 

2. 
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In the pop-up "Install Device Description" pane, select the device description file to be installed

and click "Open" to proceed with the installation.

After successful installation, you can verify in the "Device Repository" that the device

description file have been added successfully.

Preparation:

A PC installed with CODESYS software version V3.5 SP19 (64-bit).

An ED-PAC3020 device with a valid CODESYS license.

The remote I/O device description files have been downloaded from: Remote I/O Description

Files (https://vip.123pan.cn/1826505135/16632390) .

3. 

4. 

4.2.3 ​Installing Remote ​I/O Device Description File

• 

• 

• 

open in new window

ED-PAC3020

Email: sales@edatec.cn / support@edatec.cn

Web: www.edatec.cn
| Phone: +86-15921483028(China) | +86-18217351262(Overseas)

https://vip.123pan.cn/1826505135/16632390
https://vip.123pan.cn/1826505135/16632390
https://vip.123pan.cn/1826505135/16632390
https://vip.123pan.cn/1826505135/16632390
https://vip.123pan.cn/1826505135/16632390


Connect the PC, ED-PAC3020, and remote I/O devices to the same switch. Ensure that the IP

addresses of the PC, ED-PAC3020, and remote I/O devices are within the same subnet.

Steps:

Double-click the CODESYS icon on the PC desktop to open the CODESYS software. From the

menu bar, select “Tools” → “Device Repository”.

In the opened "Device Repository" pane, click "Install".

In the pop-up "Install Device Description" pane, select the I/O device decirption file to be

installed and click "Open" to proceed with the installation.

After successful installation, you can verify in the "Device Repository" that the I/O device

description file have been added successfully.

• 

1. 

2. 

3. 

4. 
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Preparation:

A PC installed with CODESYS software version V3.5 SP19 (64-bit).

The device description files and remote I/O device description files have been installed.

Connect the PC, ED-PAC3020, and remote I/O devices to the same switch. Ensure that the IP

addresses of the PC, ED-PAC3020, and remote I/O devices are within the same subnet.

Steps:

Power on the ED-PAC3020 and the remote I/O modules. Open the CODESYS software on the

PC, select "File" → "New Project" in the menu bar to open the "New Project" pane, and create a

standard project.

Select the installed device description file and click "OK".

Double-click the device, select "Scan Network" on the right, then choose the detected device

from the scan results, and click "OK" to confirm.

4.3 Hardware Configuration

• 

• 

• 

4.3.1 Create a New Project and Connect to the Device

1. 

2. 

3. 
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TIP

If the device cannot be detected during scanning, manually enter the IP address in the

target device settings to connect.

If a device login prompt appears, log in with your credentials (username and password)

or follow the instructions to register a new account.

As shown in the figure below, this indicates the device is successfully connected.

Steps:

Right-click “Device” and select “Add Device” in the menu to add the EtherCAT Master.

• 

• 

4. 

4.3.2 Adding Remote ​I/O Modules

1. 
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Double-click on the EtherCAT Master device to set the source address (Select the EtherCAT

port, which corresponds to the device's eth0 port).

Click the  button to log in to the device. A successful login is shown in the figure below.

Click on the EtherCAT Master device, select “Scan for Devices” in the right-click menu, and

copy all devices to the project after scanning is completed.

2. 

3. 

4. 

ED-PAC3020

Email: sales@edatec.cn / support@edatec.cn

Web: www.edatec.cn
| Phone: +86-15921483028(China) | +86-18217351262(Overseas)



Click the  button to log out of the device.

Double-click the slave device, configure the relevant parameters in the right-hand interface,

enable "Expert settings", select "Enable" under Select DC section, and select "Enable Sync0".

Click the  button to download the program to the device, then click the  button to run it. As

shown in the figure below, this indicates a successful operation.

The following example demonstrates practical programming using a specific coding scenario.

5. 

6. 

7. 

4.4 Programming
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Complete the development and debugging of a program for a timed blinking LED using a PNP-

type 8-channel digital output (DO) module.

Preparation:

A standard project has been created.

Hardware configuration has been completed.

A 24V compact LED lamp has been connected to the first output port of the remote DO (Digital

Output) module.

Steps:

Double-click the DO module, select "Module I/O Mapping" → "Output" in the right-hand

interface, and view the addresses of all output ports. As illustrated below, the first output port’s

address is %QX18.0 .

4.4.1 Programming Process

4.4.2 Programming Example

• 

• 

• 

1. 
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Click "PLC_PLG" to open the programming interface, where the upper section is the variable

declaration area and the lower section is the main program editing area.

Write the program code as follows:

2. 

3. 

    PROGRAM PLC_PRG

VAR

TON_TIME : TON; 

Light_Output : BOOL := FALSE; 

END_VAR

TON_TIME(IN := NOT TON_TIME.Q, 

         PT := T#0.5S); 

IF TON_TIME.Q THEN 

    Light_Output := NOT Light_Output; 

sh

sh
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After completing the program, click " " to compile it and ensure there are no errors.

Click Login to download the program to the device, then click Run to observe the LED blinking

every 0.5 seconds.

After downloading the program to the device, you can perform the Run and Stop operations.

Status Operations

Run Program In the main menu of the software interface, click the Login  button.

Stop Program In the main menu of the software interface, click the stop  button.

4. 

5. 

4.5 Operation and Maintenance

    TON_TIME(IN := FALSE); 

END_IF

%QX18.0:= Light_Output; 
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This chapter introduces how to configure system.

WARNING

The ED-PAC3020 device comes pre-installed with a valid CODESYS license by default.

Reinstalling the operating system will invalidate the CODESYS license. Do not attempt to

install the OS on your own.

Finding Device IP

Remote Login

Configuring Wi-Fi

Configuring Ethernet IP

Configuring Bluetooth

The buzzer is controlled using GPIO6.

Execute the following command to turn on the buzzer:

Execute the following command to turn off the buzzer:

5 Configuring System

5.1 Finding Device ​IP

5.2 Remote Login

5.3 Configuring Wi-Fi

5.4 Configuring Ethernet ​IP

5.5 Configuring Bluetooth

5.6 Configuring Buzzer

pinctrl set 6 op dh

sh
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Configuring RTC

This chapter introduces the configuration method of RS232 and RS485.

In the Linux environment, you can use the picocom tool to debug the serial ports RS232 and

RS485.

Execute the following command to install the picocom tool.

The ED-PAC3020 contains 1 RS232 interface, and its corresponding COM port and device files

are listed in the table below:

Number of RS232 Ports Corresponding COM Port Corresponding Device File

1 COM1 /dev/com1

Preparation:

The RS232 ports of ED-PAC3020 has been connected with external device.

Steps:

Execute the following command to open the serial port com1, and configure the serial port baud

rate to 115200.

Input commands as needed to control external device.

5.7 Configuring RTC

5.8 Configuring Serial Port

5.8.1 ​Installing Picocom Tool

5.8.2 Configuring RS232

1. 

2. 

pinctrl set 6 op dl

sudo apt-get install picocom

picocom -b 114200 /dev/com1

sh

sh

sh
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The ED-PAC3020 contains 1 RS485 interface, and its corresponding COM port and device files

are listed in the table below:

Number of RS485 Ports Corresponding COM Port Corresponding Device File

1 COM2 /dev/com2

Preparation:

The RS485 ports of ED-PAC3020 has been connected with external device.

Steps:

Execute the following command to open the serial port com2, and configure the serial port baud

rate to 115200.

Input commands as needed to control external device.

Configuring Audio

The ED-PAC3020 device comes pre-installed with a CODESYS license by default. You can back

up and restore the license by accessing the "PLC Setting" interface.

Preparation:

A Windows PC has been set up with an IP address in the same subnet as the device. For

example, if the device’s IP (1000M Ethernet port) is 192.168.0.100 , set the PC’s IP to 

192.168.0.99 .

A functioning Ethernet cable has been prepared.

Steps:

Connect the device's 1000M Ethernet port to the PC via an Ethernet cable, then power on the

device.

Enter http://192.168.0.100:8100  in the PC’s web browser to access the "PLC Setting"

interface.

In the "Codesys License Management" interface, click "Backup License" to download the

license file and save it locally.

5.8.3 Configuring RS485

1. 

2. 

5.9 Configuring Audio

5.10 CODESYS License Management

5.10.1 License Backup

• 

• 

1. 

2. 

3. 

picocom -b 115200 /dev/com2

sh
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TIP

The backed-up license file can only be restored on the same device.

Preparation:

A Windows PC has been set up with an IP address in the same subnet as the device. For

example, if the device’s IP (1000M Ethernet port) is 192.168.0.100 , set the PC’s IP to 

192.168.0.99 .

A functioning Ethernet cable has been prepared.

The backed-up license file has been obtained.

Steps:

Connect the device's 1000M Ethernet port to the PC via an Ethernet cable, then power on the

device.

Enter http://192.168.0.100:8100  in the PC’s web browser to access the "PLC Setting"

interface.

In the "Codesys License Management" interface, click "Restore License".

5.10.2 License Restore

• 

• 

• 

1. 

2. 

3. 

ED-PAC3020

Email: sales@edatec.cn / support@edatec.cn

Web: www.edatec.cn
| Phone: +86-15921483028(China) | +86-18217351262(Overseas)



As prompted, select the obtained license file under a custom path.

After a successful License Restore, a 100% progress bar will be displayed in the right-hand

panel.

Open the device’s terminal command pane, execute the following command, and restart the

device.

4. 

5. 

6. 

sudo reboot

sh
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